[image: image1.wmf]M06 Planetary Weights 

      & Scatter Graph

Grade Level: 8

Technology Objectives: 

3.9.1 The student creates column and row headings (M)

3.9.2 The student changes the column width and row height (M)

3.9.3 The student formats cells (M)

3.9.4 The student enters formulas to perform calculations (M)

3.9.5 The student copies and pastes a formula (M)

3.9.7 The student sorts information (M)

3.9.8 The student adds headers and footers (M)

3.9.9 The student adds borders (M)

3.9.10 The student creates graphs and charts from a spreadsheet (M)

4.7.1 The student plans, creates, and edits a simple spreadsheet (E)

4.7.2 The student designs an appropriate layout to report information (E)

SAUSD Math Standard: 

8.3 The student collects, organizes, and represents data sets that have more than one variable and identifies relationships among variables within a data set both manually and by using an electronic spreadsheet program.

CA Science Standard: 

9.e The student constructs appropriate graphs from data and develops quantitative statements about the relationships between variables

Software: Excel (Microsoft)

Content Skills: mass, algebra, multiplication, following directions

Internet site for additional resources: http://kids.msfc.nasa.gov

Introduction to the Lesson

Finding out how much one would weigh on different planets has always been an intriguing exercise.  Even though your mass doesn't change, it fascinates students that if they weigh 200 pounds on Earth, they will weigh only 8 pounds on Pluto!  In this lesson students will be given the Gravity Factor for each planet and then set up a spreadsheet to determine how much they would weigh on each planet.  Then, they will change their weight and watch how that change affects their weight on other planets.  Finally, they will have Excel's Chart Wizard plot the pairs of values (gravity factor v. weight) to see if they can predict their weight on our moon.
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1. See if students can describe how astronauts looked when they walked on the Moon.  They should be able to describe how the astronauts "walked" in giant leaps!  Explain that this was because the gravitational force on the moon was much less than on Earth due to the fact that the Moon has much less mass than the Earth. Gravitational pull depends on mass. So, if students were to visit other planets and moons with more or less mass than Earth’s, a scale would show they weigh more or less than they do on Earth. The force of the gravitational pull will determine their weight, which is a measure of how much their mass is attracted to a planet.  

2. Tell students that they will be creating a spreadsheet to determine what they would weigh on other planets. At first, they will use their own true weight. Then, they will experiment with changing their weight to see how that affects their weight on other planets.

3. Show students how to open Microsoft Excel. Remind students that the small boxes on the spreadsheet are called cells. The rows are numbered and the columns are lettered. Each cell can be identified by it's Column and Row, for example, Cell A1 is in Column A and Row 1.  

4. Before entering the data, students will need to Add a Header to the spreadsheet so they won't have to type their name and the date in the cells. In the header they will be able to add the title, their name, and the date.  To add a header, click on the View menu and select Header and Footer. Then, click on Custom Header and click inside the Center Section. Now, students should type in Planetary Weights.  Student will then click inside the Right Section and type their name, press return, then click on the Date Button to insert the date.  The date button has a 7 on it and is just to the left of the button with the clock on it.  The Date Button will insert a place holder that looks like &[Date] which will insert the correct date when the page is printed. Students can format the header by clicking on the A Button. Remind them that they must highlight the text they want to format.  Then, they can choose a font, style, and size. After they have made their selections, they should click OK, then OK again, and OK one more time. Note: The header will only appear on the printed page or if you select File, Print Preview.  You will not see it on the spreadsheet.

5. Student should save their spreadsheet as Planet followed by their initials.
6. Students will first enter the Label, Planets, into Cell A1.  Students will then enter the planet names in Column A beginning with Row 2 and ending with Row 10. The planets they should enter include Mercury, Venus, Earth, Mars, Jupiter, Saturn, Uranus, Neptune, and Pluto. These are all listed on the activity sheet.  After the names are entered, they will highlight Column A and format the text so that it is Bold.

7. [image: image3.wmf]Students will then enter the label Gravity Factor in Cell B1 and the gravity factors for each planet in Column B.  (Gravity Factors are listed on Activity Sheet).  After the data has been entered, students will format Column B so that the data is centered. The column is not wide enough for the label, so they will need to increase the width by double clicking on the line between Column B & C on the "gray line" at the top of the spread sheet.

8. Students will now determine how much they weigh on each planet.  They will start by adding the label, My Weight, to Cell C1.  Remind students how to enter formulas. Review that when they enter a formula, they must begin with an equal sign (=). This signals to Excel that you are entering a formula. Other signs used in entering formulas include (+) for addition, (-) for subtraction, (*) for multiplication, and ( / ) for division. Students need to refer to specific cells when they enter their formulas so that Excel knows which cells the formula applies to. For this Lesson, the formula to determine their weight is the Gravity Factor (Cell B2) times their weight.  If their weight was 120 pounds this would be typed as:

=B2*120

After the formula is typed in Cell C2, the student must press Enter or Return for the calculation to take place. Their weight will then appear in Cell C2.

9. Now, you can show students how quickly they can compute their weight for the cells in Column C by copying and pasting the formula from Cell C2. First, they should select Cell C2 by clicking on it. Then, they should point the cursor on the small box on the lower right of that cell. The pointer will change from the “fat +” to the “skinny +” Then, they should drag the corner over to cells they want to paste the formula into. Excel will automatically change the formula from the reference cell to reflect the cells in the new columns. Students can click on the cells in Column C to see how the formula changed.  For example, the formula in Cell C4 will be =B4*120.

10. Students will now add 100 pounds to their weight to see how this affects their weight on other planets.  They will label Column D More Weight.  Then they will type in the formula with their weight increased by 100 pounds.  For example, if they really weigh 120 pounds on Earth, they would write their formula for Cell D2 as =B2*(120+100).  It is essential that they include the parentheses, or Excel will perform the calculation as Cell B2 times 120 then add 100 to that answer. 

11. [image: image4.wmf]Students will also see how subtracting 50 pounds from their weight affects their weight on different planets.  They will label Column E Less Weight. Then they will type in the formula with their weight decreased by 50 pounds.  For example, if they really weigh 120 pounds on Earth, they would write their formula for Cell D2 as =B2*(120-50).  It is essential that they include the parentheses, or Excel will perform the calculation as Cell B2 times 120 then subtract 50 from that answer.

12. To make the spreadsheet easier to read, tell students to increase the size of the font and the height of the rows. To do this, students need to highlight all the data in the spreadsheet from Cell A1 to Cell E10.  First they will change the font to size 14.  They will see that part of the letters are hidden.  Then they will increase the height of the rows to accommodate the font.  Click on the Format menu and select Row and Height. Then, they should select Autofit and the row height will be automatically adjusted.

13. Finally, have students add a border to the spreadsheet. They should highlight all cells and then click on the Border button in the formatting toolbar. They should select the border that will put a line around the outside of the data as well as add lines between the columns and rows.

14. Now, have students sort the data by weight. To do this, they need to select all the spreadsheet data. Then, they need to click on Data and Sort. In the Sort By box, they should select Column C. They should keep the sort in Ascending order. Then, they can click OK. The spreadsheet should now be in order of weight. 

15. Students will now make a graph to show the relationship between the Gravity Factor and their Weight.  Remind students that the Excel "Chart Wizard" will allow them to make many different kinds of graphs.  Discuss with students that it is important that they choose the correct type of graph for their data.  Each type of graph tells a certain kind of story.  For example, a Column or Bar Graph is used when one wants to show which kind of ice cream was most popular, the number of boys and girls in each class, or anytime where there are separate groups of things that you can count.  They would use a Pie Chart and Doughnut Chart to display the contribution of each part of the group to the total group. For example, a Pie Chart would be used to show the percent of students who liked each kind of ice cream.  A Line Graph would be used to show relationships, for example, how something changes over time (i.e. a child's height in relation to his/her age) or how one thing changes in relation to another (i.e., average number of ice cream cones sold in relation cold days, warm days, and hot days).  A Scatter Graph compares pairs of values and can include a line to show any trend in the data.  It is important that students learn how to pick the kind of graph that will best illustrate their data.

16. [image: image5.wmf]Students must select the part of the spread sheet they will use for the Scatter Graph.  They will do this by highlighting the area between Cell B1 and Cell C10.  Note: If the data is not highlighted, they will be able to use the Chart Wizard, but their chart will be blank.. Students are now ready to use the Chart Wizard button (located on the standard tool bar) and then follow the directions to create an XY (Scatter) chart. The Chart Wizard will lead them through the steps of making the graph:

· Step 1 - Students should select the Scatter Chart with data points connected by lines and then click on Next. 

· Step 2 - For Series In, students must click on Columns.  Note: If students have Rows selected, their graph will have nine separate lines instead of one line with 9 data points. Students will then click on Next.

· Step 3 - Students will select to show the minor grid lines by clicking on the Gridlines tab and selecting Minor Gridlines for both the x and y axis.  Students will then click on Next.

· Step 4 - For Chart Location, students should select As Object in: and Sheet 1. Student will then click on Finish and the chart will appear on their spread sheet.  Students will need to move the chart so it fits between Rows A through F.

17. Tell students to print the spreadsheet and graph.

18. Students should be reminded to quit or exit the program when they are finished so that the computer is ready for the next student.

19. As a final check for understanding, students will be asked to estimate what our weight would be on the Moon.  The Gravity Factor for the Moon is 0.166.  Students can use their printed graph to estimate their weight on the moon.  (It should be a little less than 1/5 of their weight on earth.)

Assessment Criteria

The student created a spreadsheet and formatted the labels correctly.

The student added and formatted the headings correctly.

The student entered all of the formulas correctly.

The student changed the size of the font and the height of all of the cells.

The student sorted the information.

The student created a scatter chart correctly.

The student estimated his/her weight on the moon using the scatter chart.
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Answers for Planetary Weight Spread Sheet and Scatter Graph based on a person weighing 120 pounds:

	Planet
	Gravity Factor
	My Weight
	More weight
	Less Weight

	Pluto
	0.04
	5
	9
	2

	Mercury
	0.28
	34
	62
	14

	Mars
	0.38
	46
	84
	19

	Uranus
	0.80
	95
	175
	40

	Venus
	0.91
	109
	200
	45

	Saturn
	0.93
	111
	204
	46

	Earth
	1.00
	120
	220
	50

	Neptune
	1.13
	135
	248
	56

	Jupiter
	2.34
	281
	515
	117
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Activity Card

Part One - Make a Spread Sheet
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1. Open Excel.

2. For this assignment you will Add a Header to the spread sheet so you won't have to type your name and the date in the cells. To add a header, click on the View menu and select Header and Footer. 

· Click on Custom Header button and click inside the Center Section.  Type the title Planetary Weights. 

· Click inside the Right Section and type your name, press return, then click on the Date Button to insert the date.  The date button has a   7   on it and is just to the left of the button with the clock on it.  The Date Button will insert a place-holder that looks like &[Date] which will insert the correct date when the page is printed. 

· Format the text in the header by clicking on the font button that has the letter A on it. Remember you must highlight the text you want to format.  Then, you can choose a font, style, and size. 

· When you are finished creating the Header, click OK, then OK again, and OK one more time.

3. Enter the labels into the spread sheet as follows:

Cell A1 - Planets

Cell A2 - Mercury

Cell A3 - Venus

Cell A4 - Earth

Cell A5 - Mars

Cell A6 - Jupiter

Cell A7 - Saturn

Cell A8 - Uranus

Cell A9 - Neptune

Cell A10 - Pluto
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4. Highlight Cell A1 and format the text so that it is Bold.  Do not make the names of the planets bold.

5. Enter the label Gravity Factor in Cell B1 and the gravity factors for each planet in Column B:

Mercury - 0.28

Venus - 0.91

Earth - 1.00

Mars - 0.38

Jupiter - 2.34

Saturn - 0.93

Uranus - 0.80

Neptune - 1.13

Pluto - 0.04

6. After the data has been entered, format Column B so that the data is centered. The column is not wide enough for the label, so you will need to increase the width by double clicking on the line between Column B & C on the "gray line" at the top of the spread sheet.
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7. You will now determine how much you weigh on each planet. First add the label, My Weight, to Cell C1. The formula to determine your weight is the Gravity Factor (Cell B2) times your weight.  If your weight was 120 pounds this would be typed as:

=B2*120

After the formula is typed in Cell C2, you must press Enter or Return for the calculation to take place. Your weight will then appear in Cell C2.

8. [image: image12.wmf]Compute your weight for the other planets by copying and pasting the formula from Cell C2. Select Cell C2 by clicking on it. Then, point the cursor on the small box on the lower right of that cell. The pointer will change from the “fat +” to the “skinny +” Then, drag the corner over to cells they want to paste the formula into. Excel will automatically change the formula from the reference cell to reflect the cells in the new columns. Click on the cells in Column C to see how the formula changed.  For example, the formula in Cell C4 will be =B4*(your weight).

9. Now add 100 pounds to your weight to see how this affects your weight on other planets. Label Column D More Weight. Type in the formula with your weight increased by 100 pounds.  For example, if you really weigh 120 pounds on Earth, you would write your formula for Cell D2 as =B2*(120+100).  Note: It is essential that you include the parentheses, or Excel will perform the calculation as Cell B2 times 120 then add 100 to that answer. 
10. You will also see how subtracting 50 pounds from your weight affects your weight on different planets. Type the label Less Weight in Cell E1. Then type in the formula with your weight decreased by 50 pounds.  

11. To make the spreadsheet easier to read, you will need to increase the size of the font and the height of the rows. To do this, highlight all the data in the spreadsheet from Cell A1 to Cell E10.  First change the font to size 14.  You will see that parts of the letters are hidden.  Then increase the height of the rows to make room for the font.  Click on the Format menu and select Row and Height. Select Autofit and the row height will be automatically adjusted.

12. Add a border to the spreadsheet. Highlight all cells that contain data and then click on the Border button in the formatting toolbar. Select the border that will put a line around the outside of the data as well as add lines between the columns and rows.

13. Sort the data by weight from lightest to heaviest. To do this, select all the spreadsheet data. Then, from the top menu bar, click on Data and select Sort. In the Sort By box, select Column C and keep the sort in Ascending order. Click OK. The spreadsheet should now be in order of weight. 

Part Two - Make a Scatter Graph
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1. You will now make a graph to show the relationship between the Gravity Factor and your Weight. You will make a Scatter Graph that compares pairs of values and will include a line to show any trend in the data.  Select the part of the spreadsheet you will use for the Scatter Graph by highlighting the area between Cell B1 and Cell C10.  Note: If the data is not highlighted, you will be able to use the Chart Wizard, but your chart will be blank.. 
2. You are now ready to use the Chart Wizard button (located on the standard tool bar) and then follow the directions to create an XY (Scatter) chart. The Chart Wizard will lead you through the steps of making the graph:

· Step 1 - Select the Scatter Chart with data points connected by lines and then click on Next. 

· Step 2 - For Series In, you must click on Columns.  Note: If you have Rows selected, your graph will have nine separate lines instead of one line with 9 data points. Click on Next.

· Step 3 - Select to show the minor grid lines by clicking on the Gridlines tab and selecting Minor Gridlines for both the x and y-axis. Click on Next.

· Step 4 - For Chart Location, select As Object in: and Sheet 1. Click on Finish and the chart will appear on your spreadsheet.  You will need to move the chart so it fits between Rows A through F.

3. Print your spreadsheet and graph.

4. Look at your printed graph and estimate what your weight would be on the Moon.  The Gravity Factor for the Moon is 0.166.  

Write the following sentence on the bottom of your printed sheet:

My weight on the Moon would be about _____ pounds.
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M06 Planetary Weights & Scatter Graph
Assessment Rubric

	Criteria
	4

Advanced
	3
Proficient
	2
Basic
	1
Below Basic

	The student created a spreadsheet and formatted the labels correctly.
	Student created labels correctly, plus formatted them in such a way as to enhance the presentation.
	Student followed all the directions for creating and formatting the labels. 
	Student followed most of the directions for creating and formatting the labels.
	Student did not follow directions for creating and formatting the labels.

	The student added and formatted the header correctly.
	Student created the header correctly, plus formatted it in such a way as to enhance the presentation.
	Student followed all the directions for creating and formatting the header. 
	Student followed most of the directions for creating and formatting the header.
	Student did not follow directions for creating and formatting the header.

	The student entered all the formulas correctly.


	Student was able to assist other students in entering the correct formulas.
	Student was able to enter the correct formulas without assistance.
	Student was able to enter the correct formulas with minimal assistance
	Student was able to enter the correct formulas only with lots of assistance

	The student changed the size of the font and the height of all of the cells.


	Student was able to assist other students in changing the size of the font and height of the cells.
	Student was able to change the size of the font and height of the cells without assistance.
	Student was able to change the size of the font and height of the cells with minimal assistance
	Student was able to change the size of the font and height of the cells only with lots of assistance

	The student sorted the data from lightest to heaviest.
	Student was able to assist other students in sorting the data.
	Student was able to sort the data without assistance.
	Student was able to sort the data with minimal assistance
	Student was able to sort the data only with lots of assistance

	The student designed and created a scatter graph correctly.
	Student was able to assist other students in creating the scatter graph.
	Student was able to create the scatter graph without help.
	Student was able to create the scatter graph with minimal help
	Student was able to create the scatter graph only with lots of help

	The student was able to correctly estimate his/her weight on the Moon using his/her scatter graph.
	Student was able to assist other students in estimating their weight from their scatter graph.
	Student was able to estimate his/her weight from his/her scatter graph without help.
	Student was able to estimate his/her weight from his/her scatter graph with minimal help
	Student was able to estimate his/her weight from his/her scatter graph only with lots of help
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Save your file as planets followed by your initials
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Remember: when you enter a formula, you must begin with an equal sign (=). This signals to Excel that you are entering a formula. Other signs used in entering formulas include (+) for addition, (-) for subtraction, (*) for multiplication, and ( / ) for division. You need to refer to specific cells when you enter a formula so that Excel knows which cells the formula applies to.
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